Using GIS to Quantify Riparian Buffer Bypassing in the Coastal Plain of Virginia within the Chesapeake Bay Watershed

Lyndsey Karin Funkhouser

College of William and Mary

Follow this and additional works at: https://scholarworks.wm.edu/honorstheses

Recommended Citation
Funkhouser, Lyndsey Karin, "Using GIS to Quantify Riparian Buffer Bypassing in the Coastal Plain of Virginia within the Chesapeake Bay Watershed" (2012). Undergraduate Honors Theses. Paper 469. https://scholarworks.wm.edu/honorstheses/469

This Honors Thesis is brought to you for free and open access by the Theses, Dissertations, & Master Projects at W&M ScholarWorks. It has been accepted for inclusion in Undergraduate Honors Theses by an authorized administrator of W&M ScholarWorks. For more information, please contact scholarworks@wm.edu.
Using GIS to Quantify Riparian Buffer Bypassing in the Coastal Plain of Virginia within the Chesapeake Bay Watershed

A thesis submitted in partial fulfillment of the requirements for the degree of
Bachelor of Science in Geology
From the College of William and Mary in Virginia

Committee:
Gregory Hancock
James Kaste
Stuart Hamilton
Randy Chambers

By
Lyndsey Funkhouser

Williamsburg, Virginia
April, 2011
# Table of Contents

Table of Contents .............................................................................................................................................. 2

List of Figures .................................................................................................................................................. 3

List of Tables .................................................................................................................................................. 4

Abstract ......................................................................................................................................................... 5

Introduction and Background ......................................................................................................................... 6

Methods ......................................................................................................................................................... 10

  Flow Accumulation Analyses ................................................................................................................... 10

  Comparison Between 10 m and 2 m DEMs ............................................................................................ 15

  Field Validation ......................................................................................................................................... 19

  Slope/Area Relationship ........................................................................................................................... 22

Results ......................................................................................................................................................... 22

Discussion .................................................................................................................................................. 35

Conclusions ............................................................................................................................................... 39

References ................................................................................................................................................. 40

Appendix ..................................................................................................................................................... 42

  Appendix A: Summary data tables .......................................................................................................... 42

  Appendix B: Graphs of Distance vs. Accumulation for study fields ..................................................... 45

  Appendix C: Flow accumulation maps for study fields ........................................................................ 61

  Appendix D: Detailed Methods for flow accumulation/Excel ............................................................... 4
List of Figures

Figure 1: Field Study Locations ................................................................. 11

Figure 2: Watershed comparison between 10 m and 2 m elevation data ..................16

Figure 3: Distance vs. drainage area comparison between 10 m and 2 m elevation data 17

Figure 4: Ranking vs. drainage area comparison between 10 m and 2 m elevation data 18

Figure 5: Photo of class 4 channelization in James City County .............................20

Figure 6: Photo of class 3 channelization in James City County .............................21

Figure 7: Mean percent of field drainage by 10 highest flow accumulation points ....24

Figure 8: Percent of field drainage by individual high flow accumulation points

   Figure 8A: Study fields in Charles City County VA ........................................25

   Figure 8B: Study fields in New Kent County VA .............................................26

   Figure 8C: Study fields in James City County VA ...........................................27

Figure 9: Fraction of field drained by 10 highest flow accumulation locations vs. the field
area and field margin ............................................................................................29

Figure 10: Fraction of field drained by the 10 highest flow accumulation locations vs. the
field area and field margin length ........................................................................30

Figure 11: Slope/area relationship for margin locations observed during in-field study ..34
List of Tables

Table 1: Summary of data for in-field surface flow evidence points .....................................19
Abstract

Forested riparian buffers are intended to reduce the sediment and nutrient loads to streams delivered by agricultural runoff. Within the Chesapeake Bay Watershed, buffers are mandated to be 100’ wide along agricultural fields bordered by perennial streams. When flow into buffers is widely disseminated buffers have the potential to significantly reduce pollutant levels entering streams. However, several studies show that flow across buffers is often concentrated, producing channelized flow that bypasses the buffer and presumably reduces buffer effectiveness. Previous studies have relied on field observations in relatively few locations, however, and the extent of bypassing is not well constrained. We hypothesize that buffer bypassing and the associated reduction in buffer effectiveness is a widespread phenomenon. Here we use GIS to determine flow patterns on agricultural fields and to identify locations of concentrated flow through buffers in the Virginia Coastal Plain within the Chesapeake Bay Watershed. Using DEMs with ≤10m resolution, we determine flow accumulation along field margins and identify points with flow accumulation sufficient to generate concentrated flow into buffers. Flow accumulation data from 27 fields has shown that 51% to 91% of the total area draining to the field margins pass through 10 discrete points, representing <1% of the field margin length. Using in-field observations we have located channels and surface flow evidence within riparian buffers and using GIS we have generated a slope/area relationship at these locations. Our results show a relationship of decreasing slope with increasing area necessary for channel initiation at the buffer. GIS flow accumulation and slope data should be used as precision tools in the placement of riparian buffers to maximize buffer effectiveness and reduce buffer-bypassing.
Introduction/Background

The Chesapeake Bay is the United States’ largest estuary. The Bay’s watershed is 165,800 km$^2$ and extends into Delaware, Maryland, Pennsylvania, Virginia, West Virginia, New York and Washington D.C. The Bay stretches 314 km from latitude 36°50’ to 39°40’ N and has 17,000 km of tidal shoreline (Baird and Ulanoxicz 1989; Chesapeake Bay Foundation, 2012). 150 major rivers flow into the Bay, with the Susquehanna River providing 50% of total fresh water inputs (Baird and Ulanoxicz 1989; Chesapeake Bay Foundation, 2012). Common among estuaries, the Bay is extremely productive and supports over 3,600 species of plant and animal life. Annually, more than 500 million pounds of seafood are harvested from the Bay, representing only a fraction of the economic resource provided to the surrounding cities (Chesapeake Bay Foundation, 2012). Water in the Bay is partially mixed and exhibits vertical thermohaline stratification (Taft et al. 1980). The salinity gradient strengthens between the months of February and May with increased fresh water inputs to the less dense surface water. Enhanced stratification reduces the circulation of the Bay’s water column, short circuiting oxygen renewal to deep waters and creating a natural temporary anoxic region (Taft et al. 1980).

Deep-water dissolved oxygen (DO) depletion due to seasonal enhanced stratification is a common feature seen in estuaries. Zones of DO concentrations below 2mg/l form seasonally in deeper regions of the Bay, classified as moderate hypoxia to anoxia. Organisms within these zones may be exposed to anoxic conditions beyond their tolerance range are likely to experience harm (Hagy et al. 2004; Officer et al. 1984).

Eutrophication contributes to deep water DO depletion and is often the product of surface
water nutrient renewal during upwelling. Eutrophication is increased by the addition of dissolved and particulate nutrients in river waters entering the Bay from the watershed. The extent of hypoxia in the Chesapeake Bay has been positively correlated with nitrogen loading by the Susquehanna River between the years of 1950 – 2001 (Officer et al. 1984). The seasonal deep-water anoxic region of the bay has propagated both laterally and temporally since 1950 (Hagy et al. 2004; Officer et al. 1984). The increase in duration and spatial scale of anoxia has brought harm to benthic organisms including oysters, clams, mollusks, crustaceans, algae, phytoplankton and bacteria. In the 2010 edition of the Chesapeake Bay Foundation’s annual State of The Bay report nitrogen and phosphorous received scores of 16 and 23 respectively. Scores are relative to the pre-colonial state of the Bay, which would receive a 100. Pollution levels, natural habitat and the health of fisheries are evaluated annually to determine the State of the Bay’s overall score (Chesapeake Bay Foundation, 2012).

Agricultural production is the largest source of nutrient pollution in the Bay. 40% of total nitrogen and 50% of total phosphorous inputs can be traced to agricultural point and non-point sources within the watershed (Chesapeake Bay Foundation, 2012). Long-term manure and fertilizer applications to agricultural fields, which exceed the uptake by crops, will accumulate nutrients in the soils (Sharpley et al. 1994). Nutrient loads in runoff vary depending on crop cover, tillage practices and timing of recent manure application (Daverede et al. 2003; Andraski and Bundy 2003, Andraski et al. 2003). Waste from poultry production also contributes largely to nitrogen loading in the Bay as a point source (Chesapeake Bay Foundation). Diebel et al. (2007) suggest targeting non-
point agricultural pollution in upper watershed locations could reduce total sediment loads for the entire state of Wisconsin by 20%.

In attempts to reduce agricultural pollution, states have established mandatory forested riparian buffer strips along tidal streams and shores. The state of Virginia requires a 100 foot buffer strip along perennial streams located within or contributing to tidal wetlands, tidal shores and non-tidal wetlands connected by surface flow (as established in The Chesapeake Bay Preservation Act of 1988). Riparian buffers have been heavily promoted by federal and state regulations due to the proven effectiveness of vegetation at reducing sediment and nutrient pollution. Studies conducted within a riparian buffer have shown a reduction of sediment leaving the watershed of 80% - 90% (Daniels and Gilliam 1996; Cooper et al. 1987). Clausen et al. (2000) measured a 73% reduction in total phosphorous and a 52% reduction in nitrate concentrations post conversion of agricultural field to riparian buffer. Reduction of nitrogen takes place within the buffer via plant uptake and denitrification (25%-50% reduction) in saturated soils (Clausen et al. 2000; Lowerance et al. 1997). However, incision within the buffer can reduce the contact area of surface water with vegetation and also lower the water table, creating an oxygenated zone and decreasing denitrification potential. Empirical studies of the ability of riparian buffers to reduce pollution suggest effectiveness is dependent upon the contact area and time of water with vegetation (Lowerance et al. 1997).

Data collected on buffer effectiveness assumes diffuse flow entering the buffer and uniform pollution reduction throughout the entire vegetated area (as discussed in Dosskey et al. 2005). Dosskey et al. (2002) identified locations of incision within riparian
buffers and estimated reduction of buffer effectiveness. Dosskey et al. (2002) used in-field observations to determine area contributing flow to channelized locations on four study farms in Nebraska. With the area of buffer contacting surface flow (defined as effective buffer area) and the gross buffer area along the field margin (total planted riparian buffer), Dosskey et al. (2002) were able to determine the impact of concentrated flow on filtration potential via mathematical modeling. The VFSMOD (Vegetative Filter Strip Modeling System) model estimates sediment trapping efficiency of an agricultural field riparian buffer. Variables in the model include: ratio of field area to buffer area, soil texture, precipitation perimeters, slope, management factor and curve number (Dosskey et al. 2002). Replacing the value of total buffer area with effective buffer area predicts a decrease from 41%-99% to 34%-43% of sediment removed from surface flow by the riparian buffer (Dosskey et al. 2002).

We define the occurrence of incision within the riparian buffer as buffer-bypassing. Dosskey et al. (2005) suggested this phenomenon is a common occurrence and the use of precision information needs to be used for designing buffer width and placement in order to maximize pollution reduction. Buffer-bypassing has not previously been quantified within the Chesapeake Bay Watershed. Even with the establishment of mandatory buffer strips, high nutrient and sediment loading to the Bay has continued, suggesting bypassing of the buffers may be occurring. Geographic Information Systems is the prime tool for predicting high flow accumulation locations and potential channelization within the buffer. With the use of Digital Elevation Models (DEMs) we will determine:

1. The extent of flow accumulation concentration at the field margin
2. The slope/area relationship necessary for channelization within the buffer
   a. The ability of GIS to predict these locations using this identified relationship, and therefore the use of GIS as a precision tool in riparian buffer design

Methods (detailed bulleted GIS methods in Appendix D)

Determining the Extent of Flow Accumulation Concentration

Counties included in the study were selected based on availability of riparian buffer shapefiles from the individual county’s GIS department. Study fields were selected if bordering a riparian buffer on at least one edge of the field outline and if the field margin could be easily distinguished in most recently available imagery. In ArcMap the riparian buffer shapefiles were viewed, overlaying the imagery, and potential field locations were recorded in a point file. Initially, approximately 50 fields were selected based on proximity to riparian buffer. However, fields were ultimately selected if their margins were significantly bordered by buffer and easily distinguishable. Final selected fields for analysis can be seen in Figure 1.
Figure 1: Map of study locations for fields included in flow accumulation analyses. Three counties shown are located in the Virginia Coastal Plain and within the Chesapeake Bay Watershed.
Flow accumulation analysis utilized tools in ArcMap 10 which could predict surface flow paths based on elevation data. We began with a raw elevation data set in 10, 2 or 1.5 meter resolution. The 10 m resolution elevation models were obtained from the USGS Seamless server (U.S. Geological Survey, 2011). Elevation data in 2 m or 1.2 m resolution was downloaded from the USGS Eleven County LiDAR dataset (USGS, 2011) for the Virginia counties and from Digital Coast by NOAA (National Ocean Atmospheric Association) for the fields in Maryland. All elevation data sets were reprojected in ArcMap to be in the UTM-NAD 1983 zone 18 North projection. This projection was used with all data sets and features. Following reprojection each DEM was input into the fill tool to fill “sinks” in the dataset (esri, 2011).

We utilized the hydrology toolbox in ArcMap 10 to determine flow paths and flow accumulation on each field. We determined flow direction on the filled DEM using the flow direction tool. The flow direction tool uses the elevation of each raster cell in relation to its neighbors and assumes flow will go to the steepest downhill neighbor (esri, 2011). We determined flow accumulation on the flow direction raster using the flow accumulation tool. The resulting raster assigns a value to each cell equal to the total pixels draining into that cell (esri, 2011).

The field outline was created following the completion of the hydrology tools to extract the flow accumulation values exiting at the field margin. A polyline file was added to ArcCatalog and imported into ArcMap. The polyline was created during an editing session by snapping the vertices of each line segment within the shapefile to the flow accumulation raster. Prior to utilizing snapping, the flow accumulation raster was converted to a point file using the data management toolbox. During polyline creation the
flow accumulation raster was displayed with 55% transparency above the most recently available imagery. Beginning in a corner of the field and continuing counter-clockwise, the outline was created by following the field edge according to the imagery, including accumulated flow paths as shown by the flow accumulation raster, snapping to flow accumulation points. In the case of a major road cutting through the field, the road was used as the field edge. Small roads, buildings within the field and tree lines less than 20 meters were generally included in the field and the outline was created around them. The ETGeoWizards toolbox was used to extract the flow accumulation values by the vertices created in the polyline (esri, 2011). Within the toolbox the Features to 3D tool was used with the polyline and the flow accumulation raster as the inputs. This file could then be input into the Feature Class Z to ASCII tool in the 3D Analyst conversion toolbox. Using this tool we were able to create a profile of flow accumulation vs. distance around the field from the initial starting location, as well as an XYZ file with point locations and accumulation values, both as text files. The profiles and the XYZ files were delimited by a comma for easy transfer into Excel for later analyses. The files were opened in ArcCatalog so titles could be added and then added to Arcmap using Add XY data under the file drop down menu. The files were then exported as shapefiles and added to the table of contents in the ArcMap window.

In order to correct for flow coming onto the field or flowing parallel to the field margin, the flow direction at the field margin was evaluated. This was done by converting the flow direction raster to a point file and then clipping this file by the polyline. Margin flow direction points were displayed as flow direction arrows pointing in the direction of flow. An attribute titled *Negative* was added to the attribute table of the XYZ point file
and a flow direction onto the field was defined as the accumulation value \*(-1). Points within the XYZ shapefile with a flow direction parallel to the field outline were defined as zero under the \textit{Negative} attribute. An alternate method accounting for flow direction was used on higher resolution data sets. This method utilized Excel and the known flow direction values to determine direction of flow in relation to the field margin. Once the accumulation value was made negative or zero the table could be imported into ArcMap as XY Data. The XYZ shapefile was then joined with the profile shapefile allowing distance around the field to be known for each final calculated point. This joined attribute table was exported as a text file and was ready to be analyzed in Excel. Excel was utilized to correct for flow direction on higher resolution data to save time in analysis.

In a spreadsheet, area drained at each point on the field outline was calculated by multiplying the \textit{Negative} values by the square of the pixel size from the original elevation data set. The summation of these values provided the total area of the field, assuming all flow onto the field was made negative and subtracted from exiting flow. The summation of only the positive accumulation values provided the total area contributing drainage which exited the field, including area not on the field. The fraction of total drainage exiting the field for each point location was calculated by dividing the area contributing to each exit point by the total area of drainage. Potential channel locations were determined using the graph of distance vs. cumulative fraction of field drained. Steep changes on the Y-axis (positive increases on the graph) correlate to a large percentage of total drainage exiting at these locations. Also, the percentage of total drainage comprised by the ten highest exiting flow accumulations was compared across fields to evaluate extent of flow accumulation concentration. These percentages were plotted against field
characteristics including: area, field perimeter length, relief, and maximum elevation. Listed field characteristics were derived from the original elevation data, the profile file and the total area calculated by summation of areas drained, as described earlier.

**Comparison between 10 m and 2 m DEMs**

Analyses were performed on four fields using elevation data in both 10 m and 2 m resolution to test if resulting flow accumulations were influenced by DEM resolution. Results from each resolution were also compared to ensure agricultural field microrelief would be sufficiently detected using 10 m DEMS. Results comparisons between resolutions were done using the following: drainage area polygon for high flow accumulation points (Figure 2), cumulative drainage as a function of distance around field outline (Figure 3), and ranking of point (based on flow accumulation) with the area draining through that point (Figure 4). Analyzing the match between resolutions in each of the results comparison categories confirmed that flow accumulation is not controlled by DEM resolution.
Figure 2: Example watershed comparison between 10 m and 2 m DEM resolutions for a study field in Charles County, MD. Although catchment boundaries are not an exact match, total area drained through this location is similar. Watershed comparisons were done on all resolution comparison fields.
Figure 3: Example distance vs. fraction of field drained comparison between 10 m and 2 m DEM resolutions for a study field in Charles County, MD (Field also shown in Figure 2). Large increases in fraction of field drained represent points of concentrated flow accumulation at the field margin. Large decreases in fraction of field drained represent flow entering the field. Shaded boxes identify drainage exiting directly into the riparian buffer. Concentrated flow entering directly into the riparian buffer is an example of buffer-bypassing. Comparisons of distance vs. fraction of field drained were done on all resolution comparison study fields.
Figure 4: Example ranking vs. drainage area comparison between 10 m and 2 m DEM resolutions for a study field in Charles County, MD (Field also shown in Figures 2 & 3). This graph highlights the similarity in utilizing various resolution DEMs to predict high flow accumulation locations (the 10 highest ranking locations according to flow accumulation value). Ranking vs. accumulation comparisons were done on all resolution comparison fields.
Field Validation

In-field validation was used to determine evidence of flow at locations of high flow accumulation identified in our GIS analysis and to identify the conditions under which channels are generated in the field. Four agricultural fields previously analyzed in ArcMap were visited to determine the existence and location of channels exiting the field and entering the riparian buffer. We walked the margin of field bordering riparian buffer and used vegetation and topography to locate areas of high surface flow. If evidence of surface flow was visible on the field, we entered into the buffer to locate observable flow paths or channelization. These locations were recorded using a Trimble GeoXT GPS unit and given a class value based on extent of incision:

- Class 1 – unidirectional debris movement exposing sediment
- Class 2 – unidirectional debris and standing plant movement, sediment removal
- Class 3 - incision less than 20cm depth (Figure 5)
- Class 4 – incision greater than 20cm depth (Figure 6)

Channel width and depth measurements were made in class 3 and 4 channels.
Figure 5: Photo of in-field class 4 channelization, with greater than 20 cm of incision depth. This channel is located on Field 25 in James City County.
Figure 6: Photo of in-field class 3 channelization, with less than 20 cm of incision depth. This channel is located on field 25 in James City County.
Slope/Area Relationship

GPS locations of in-field surface flow evidence were imported into ArcMap to be compared with flow accumulation obtained from DEM analysis. Field channel locations and areas of high flow were correlated with flow accumulation cells using location, imagery and field notes. GPS points were often not in the exact location of GIS points due to the inability of the GPS unit to record measurements unless well onto the planted field, away from the tree line. Area contributing flow and slope at the margin location were generated in ArcMap using the high flow accumulation point assigned to the GPS in-field surface flow location. Slope was calculated using the slope tool under surface tools in the spatial analyst toolbox. The input raster was the filled DEM and the output raster was generated in degree measurements with a Z factor of 1 (Z factor is used to adjust the Z units if they differ from the XY units). Area was calculated as described above. In a spreadsheet, slope vs. area was plotted for each class of in-field surface flow locations and for field margin points in which no evidence of surface flow was seen. This allowed us to evaluate the relationship between slope and contributing area at which necessary for channels to begin to form or fully incise.

Results

For all 27 fields analyzed, over 50% of the total exiting drainage flowed through the ten highest flow accumulation locations. Thus, we focus on comparing the extent of flow concentration using the 10 points of highest flow accumulation for each field. The sums of drainage from the 10 locations with greatest accumulation area drain from 51% to 91% of the total field drainage. The location of highest flow accumulation for each
field ranges from 9% to 62% of the total field drainage and averages 30% (Figures 7, 8 A-C). The greatest variance in percent of total drainage was seen in the highest ranking flow accumulation location (Figures 7, 8 A-C). In figure 7, individual percentages drained by the highest ten points are shown for each study field.

The flow path of the ten highest flow accumulation points was determined using the flow accumulation layer. 252 out of 270 of the total high accumulation points entered into the riparian buffer after exiting the field. All ten highest flow accumulation points entered into the riparian buffer on 22 out of 27 of the fields studied.
Figure 7: Mean percent of field drained for all 27 fields by point rank; point 1 being the point on each field with highest flow accumulation. Minimum, maximum and average fraction of field drained by each point is shown.
Figure 8A: Percent of total field drainage, calculated using flow accumulation value, for each of the 10 highest flow accumulation ranking locations in Charles City County study fields. The red bar represents the highest ranking location for each field with the above colored bars representing the remaining 9 point locations. Wide grey bars are total drainage through the ten highest points.
Figure 8B: Percent of total field drainage, calculated using flow accumulation value, for each of the 10 highest flow accumulation ranking locations in James City County study fields. The red bar represents the highest ranking location for each field with the above colored bars representing the remaining 9 point locations. Wide grey bars are total drainage through the ten highest points.
Figure 8C: Percent of total field drainage, calculated using flow accumulation value, for each of the 10 highest flow accumulation ranking locations in New Kent County study fields. The red bar represents the highest ranking location for each field with the above colored bars representing the remaining 9 point locations. Wide grey bars are total drainage through the ten highest points.
Field margin lengths ranged from 1.8 km to 8.9 km. No clear relationship exists between field margin length and fraction of field drained by the 10 highest flow accumulation points across all fields studied (Figure 9). Field areas ranged from 1 km$^2$ to 1.4 km$^2$. No clear relationship exists between field area and fraction of field drained by the 10 highest flow accumulation points across all fields studied (Figure 9). However, fields with greater than 80% of total drainage exiting through the ten highest points show correlation between size and extent of concentration.

Maximum elevation of fields studied ranged from 4.9 m to 127.4 m above sea level, representing the distance of the field from the main tributary (Either the James or York River). No clear relationship exists between maximum elevation and extent of flow accumulation concentration within the 10 highest accumulation points (Figure 10). Relief on the study fields ranged from 2.5 m to 58.6 m. Again, no clear relationship was found when comparing relief with extent of flow concentration (Figure 10).
Figure 9: Fraction of field drained by 10 highest flow accumulation locations vs. the field area and field margin length. Fields with greatest flow accumulation concentration (greater than 80%) were not over 0.4 km$^2$ in total field area. Fields with less than 80% flow accumulation concentration did not show any clear relationships.
Figure 10: Fraction of field drained by 10 highest flow accumulation locations vs. the field maximum elevation and field relief. Extent of flow accumulation appears to be independent of maximum elevation, used as a proxy for the distance from the main tributary. Extent of flow accumulation also appears to be independent of relief on the field.
Field verification of channelization and surface flow was performed on four fields, along the margin of field bordering a riparian buffer. In the four fields analyzed, we identified 33 point locations with evidence of surface flow or channelization along the field margins. Of these 8 were given the class of 4 (greater than 20 cm incision). Areas draining through these locations were obtained using GIS and range from 1,220 m$^2$ to 94,500 m$^2$. The slopes at each point location were also obtained in ArcMap and range from 1.3 degrees to 28 degrees (Table 1).

Class 4 locations often showed ponding on the field and a wide, dispersed flow path prior to channel initiation several feet within the buffer. Class 3 channels were identified most frequently and these were described as less than 20 cm of incision, often with slight vegetation growth within the channel. Again these channels were characterized by a wide flow path on the field and channel initiation within the buffer.
<table>
<thead>
<tr>
<th>Class</th>
<th>Count</th>
<th>Drainage Area Range (m)</th>
<th>Slope Range (degrees)</th>
<th>Descriptors</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6</td>
<td>470 - 8300</td>
<td>4.6 - 37</td>
<td>Unidirectional debris movement exposing sediment</td>
</tr>
<tr>
<td>2</td>
<td>8</td>
<td>140 - 19800</td>
<td>1.1 - 18</td>
<td>Unidirectional debris and standing plant movement, sediment removal</td>
</tr>
<tr>
<td>3</td>
<td>11</td>
<td>530 - 81600</td>
<td>0.9 - 17</td>
<td>Incision; less than 20 cm depth</td>
</tr>
<tr>
<td>4</td>
<td>8</td>
<td>1220 - 94500</td>
<td>1.3 - 28</td>
<td>Incision; greater than 20 cm depth</td>
</tr>
</tbody>
</table>

Table 1: Field surface flow evidence; each location given a class based on size and extent of flow evidence. Drainage areas and slope calculated in GIS using closest high flow accumulation point to GPS location.
The drainage areas and slopes for the 33 field locations of surface flow and channelization were graphed to estimate a relationship necessary for channel initiation. Our results show drainage area decreasing with increasing slope (Figure 11). This relationship holds true throughout all classes of incision. Using an exponential fit for the points showing channel initiation at the field margin we have identified an equation describing the relationship of area/slope (Figure 11). Using field notes, we plotted channels occurring within the buffer with channel heads located on the field (Figure 11, bolded larger circles). These points exist above the slope/area relationship necessary for channel initiation. Area/slope relationships for field margin points with no surface flow evidence plotted beneath the relationship area, with shallower slopes and smaller drainage areas. However, this is not always the case pointing to contributing factors to incision other than drainage area and slope.
Figure 11: Drainage area to slope relationship for in-field surface flow locations. Grey points showing no channelization were determined in GIS using the margin values excluding points with apparent surface flow in the field. Bold circles show channel locations not at the channel head due to channelization beginning on the field. Classes indicate severity of incision or surface flow evidence in the field. Higher class points generally exist in the upper portion of the region while lower classes are in the lower portions. The exponential fit to channel head points (class 3 and 4) is shown and has an equation of $y = 1880e^{-0.1x}$. 

$y = 12880e^{-0.1x}$

$R^2 = 0.2584$
During in-field channel and surface flow identification the largest channel width measured was approximately 1.5 meters. Using this maximum value we can estimate the percent of field margin through which exiting field drainage flows. The percentage of field margin through which the ten highest flow accumulation points exit ranges from 0.2% to 0.8%. Two of the studied fields showed the highest 10 accumulation points draining 91% of the total exiting drainage. These two points also both utilize only 0.4% of the total field margin length.

**Discussion**

Analyses of flow accumulation at the field margin indicate concentrated flow patterns are prevalent in the Virginia Coastal Plain (Figures 7 & 8, Appendix A). The sums of drainage from the 10 locations with greatest accumulation area drain from 51% to 91% of the total field drainage for all fields studied (Figure 8). Concentrating the majority of flow through ten exit locations reduces the utilized field margin from 0.2% to 0.8% of its original length. In extreme instances of flow concentration, 62% of the field drainage exited the field in one drainage location (Figure 8A). Only one field studied showed the highest flow accumulation location with a drainage area less than 15% of the total field area. These patterns of flow accumulation indicate riparian buffer in place along field margins are not receiving disperse runoff but rather high volume amounts concentrated by field topography. Concentrated surface flow by topography is both common and natural in the Coastal Plain; however high surface flow due to agricultural land use results in the concentration becoming problematic from an erosion standpoint. Some error arises within the methods of identifying flow accumulation concentration. Selection of margin points included within the dataset is entirely up to the individual
selecting points and the display of flow accumulation raster. However, error will be least if the display methods are consistent across all analyses.

Dosskey and colleagues (Dosskey et al., 2002) found effective (utilized) riparian buffer area to be 6% to 81% of the gross buffer area, using in-field determination of concentrated surface flow paths. Modeling sediment trapping efficiency using the effective buffer area estimated sediment trapping potential of the riparian buffer would be much lower during instances of concentrated flow (Dosskey et al., 2002). Our study did not evaluate effective buffer area but rather identified points of extreme flow concentration and reduction of utilized field margin. Our data compliment previous flow concentration studies by demonstrating the ability of field topography to concentrate runoff to an extent which promotes channelization through the buffer. If channelization persists through the buffer, runoff will enter the perennial “buffered” stream without contacting vegetation. Contrary to a reduced effective buffer area and consequent reduction in filtration potential, points of channelization will result in absolute elimination of riparian buffer filtration, or buffer by-passing. Our flow accumulation data predict the majority of runoff exiting fields in the Virginia Coastal Plain will not be filtered by the riparian buffer but will by-pass into the nearby stream. Previous work monitored a by-passing channel in Charles City county during storm events and found greater than 11,000 m$^3$ of water exited the field at one location and carried approximately 90 kg/ha of suspended sediment (Hopkins, 2011). The drainage area for the study channel was 40% of the total field area (Hopkins, 2011). Our findings suggest that locations of concentrated flow comparable to this location and greater are common in the Coastal
Plain, suggesting flow volumes and suspended sediment fluxes measured in previous study occur frequently during storm events across the area.

Focused on absolute elimination of riparian buffer filtration, this study attempted to further predict channelization by identifying the slope/area relationship necessary for channel initiation at the field margin. In-field validation of channel occurrence was correlated with GIS high flow accumulation locations and the slope/area relationship was generated using tools in GIS. In-field validation of high flow accumulation locations identified a range of severity in evidence of surface flow along field margins. 17 out of 33 point locations of surface flow showed incision at the field margin, and into the buffer (Table 1). However, three of these locations were channels which had initiated on the field and not channel heads beginning at the field margin. The remaining locations of surface flow evidence consisted of vegetation and plant debris moving in a unidirectional manner towards the field margin; key examples of the reduced effective buffer area observed by Dosskey et al. (Dosskey et al., 2002).

The plot of drainage area against local slope at points of field validated surface flow defines a clear inverse relationship (Figure 11). This is consistent with previous studies on conditions promoting the initiation of channels and the location of channel heads (Montgomery and Dietrich, 1988). Montgomery and Dietrich (Montgomery and Dietrich, 1988) identified an inverse relationship between source area and local hillslope gradient for slopes between 5 – 45 degrees in locations with a range of underlying geology. However, their study focused only on channel heads and not locations with high surface flow evidence and no channel initiation. The identified inverse relationship was consistent for points of incision and points with high surface flow evidence but no
current in-field incision. However, the points of no incision generally exist in the lower bounds of the relationship area (Figure 11). This indicates that an increase in local slope for these points or an increase in concentration and drainage area could lead to channel initiation. Points of channel occurrence with initiation on the field were also included in the plot but generally exist in the upper bounds of the relationship (Figure 11). This further confirms the relationship identifies the slope/area necessary for channel initiation as these locations are beyond the point of channel formation. Several of the class 3 and 4 points were in the lower bounds of the relationship and could be explained by practices used by the farmers to reduce channelization on the field. While in the field we would often see erosion prevention methods in place at locations of high runoff, altering our ability to place a correct class based on incision. We fit an exponential trendline to points showing channel head locations (class 3 and 4). The equation of this line is \( y=12880e^{-0.1x} \) with an \( R^2 \) value of 0.2584. The low \( R^2 \) value demonstrates the variation in the data which can be attributed to the wide range in drainage areas. This relationship can be used in conjunction with flow accumulation concentration to locate points along field margins with high incision potential. The plot of drainage area along the buffered margin and local slope can be utilized for high flow accumulation locations to identify points falling within the region of channel initiation.

All instances of surface flow evidence matched well with GIS predicted flow accumulation maps. However, limitations arise when utilizing GPS units in forested areas. Often satellite acquisition required moving a significant distance from the field margin, into the field. This eliminated our ability to use GIS tools for distance comparisons between GPS locations and GIS flow concentration locations, as a gauge for
GIS flow accumulation location accuracy. With the aid of accurate field notes and recent imagery, in-field surface flow evidence locations were matched manually with GIS high flow accumulation points and drainage area and local slope were calculated.

Riparian buffer strips have been mandated in the Virginia Coastal Plain for 24 years however dissolved oxygen levels remain at ecologically detrimental levels (Chesapeake Bay Foundation, 2012). Our results show that field topography is concentrating the majority of runoff into by-passing channels, eliminating the role of buffers in filtering pollutants from surface runoff. Further study on flow accumulation in the Chesapeake Bay watershed, not within the Virginia Coastal Plain could lead to greater understanding of the prevalence of buffer by-passing across the watershed and the addition of excess nutrients via channelization.

Conclusions

The reduction of utilized field margin to less than 1% of its original length indicates that riparian buffer along the margin is not receiving flow evenly and channelization may be occurring at the concentrated locations. All fields analyzed for flow accumulation concentrate over 50% of total exiting drainage through only 10 locations along the field margin. These 10 high accumulation locations comprise from 0.25 to 0.8% of the total field margin. Concentrated flow due to topography is common in the Coastal plain however high volume runoff from agricultural fields during storm events can lead to incision within the riparian buffer. According to flow accumulation data, 93% of these concentrated locations enter into the riparian buffer after leaving the field. In-field study confirms the existence of channels at several of the high flow
accumulation locations identified, and previous work has shown significant water volumes and pollutant levels in these channels during storm events. Using the drainage area and slope of points at channel heads, we are able to find the relationship necessary for channel formation. Our results show decreasing drainage area with increasing slope for channel initiation to occur. This relationship can be used in conjunction with flow accumulation data to identify potential buffer by-passing locations along field margins. Using precision tools such as GIS will allow riparian buffer creation to be more specific to field drainage patterns and capture greater runoff. Miles of riparian buffers are currently mandated in the Virginia Coastal Plain. Identifying locations of buffer by-passing would be a significant tool in reducing nutrient loading to the Chesapeake Bay from non-point sources within the watershed.
References


Baird, D., Ulanowicz, R. E., The Seasonal Dynamics of The Chesapeake Bay Ecosystem, Ecological Monographs 59 (4), 329 - 364


USGS (2011), Eleven County Virginia LiDAR – ARRA LiDAR, Dewberry, Tampa Florida, January 31, 2011
Appendix A

Summary tables of the ten highest flow accumulation locations for all 27 fields studied (only higher resolution data included for field 25). Summary tables include data utilized in figures 4-7 in the results section.

<table>
<thead>
<tr>
<th>Field</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point 1 % of Total Drainage</td>
<td>0.16217</td>
<td>0.61908</td>
<td>0.4055</td>
<td>0.16477</td>
<td>0.21096</td>
<td>0.17383</td>
</tr>
<tr>
<td>Point 2 % of Total Drainage</td>
<td>0.14691</td>
<td>0.04907</td>
<td>0.2379</td>
<td>0.11813</td>
<td>0.10961</td>
<td>0.12118</td>
</tr>
<tr>
<td>Point 3 % of Total Drainage</td>
<td>0.1303</td>
<td>0.03953</td>
<td>0.12642</td>
<td>0.11769</td>
<td>0.08759</td>
<td>0.08363</td>
</tr>
<tr>
<td>Point 4 % of Total Drainage</td>
<td>0.07925</td>
<td>0.03402</td>
<td>0.05176</td>
<td>0.11749</td>
<td>0.07182</td>
<td>0.08012</td>
</tr>
<tr>
<td>Point 5 % of Total Drainage</td>
<td>0.07251</td>
<td>0.03349</td>
<td>0.04056</td>
<td>0.04994</td>
<td>0.05531</td>
<td>0.07478</td>
</tr>
<tr>
<td>Point 6 % of Total Drainage</td>
<td>0.04902</td>
<td>0.01865</td>
<td>0.01978</td>
<td>0.04607</td>
<td>0.05506</td>
<td>0.07188</td>
</tr>
<tr>
<td>Point 7 % of Total Drainage</td>
<td>0.04803</td>
<td>0.01293</td>
<td>0.01008</td>
<td>0.046</td>
<td>0.0543</td>
<td>0.05837</td>
</tr>
<tr>
<td>Point 8 % of Total Drainage</td>
<td>0.03742</td>
<td>0.01219</td>
<td>0.00821</td>
<td>0.04467</td>
<td>0.0468</td>
<td>0.05418</td>
</tr>
<tr>
<td>Point 9 % of Total Drainage</td>
<td>0.02211</td>
<td>0.00911</td>
<td>0.00722</td>
<td>0.03859</td>
<td>0.03929</td>
<td>0.02862</td>
</tr>
<tr>
<td>Point 10 % of Total Drainage</td>
<td>0.01477</td>
<td>0.00615</td>
<td>0.0046</td>
<td>0.02969</td>
<td>0.02177</td>
<td>0.01938</td>
</tr>
<tr>
<td>Total Top Ten Drainage</td>
<td>0.76249</td>
<td>0.83423</td>
<td>0.91203</td>
<td>0.77303</td>
<td>0.7525</td>
<td>0.76597</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min Elevation</td>
<td>12.8047</td>
<td>6.90458</td>
<td>9.23233</td>
<td>20.9905</td>
<td>27.9776</td>
<td>11.3152</td>
</tr>
<tr>
<td>Max Elevation</td>
<td>25.8593</td>
<td>24.3666</td>
<td>18.4608</td>
<td>36.6906</td>
<td>35.0632</td>
<td>21.2094</td>
</tr>
<tr>
<td>Relief</td>
<td>13.0546</td>
<td>17.462</td>
<td>9.22848</td>
<td>15.7002</td>
<td>7.08559</td>
<td>9.89421</td>
</tr>
<tr>
<td>Area</td>
<td>1414776</td>
<td>344118</td>
<td>344118</td>
<td>898577</td>
<td>262959</td>
<td>980354</td>
</tr>
<tr>
<td>Area (skm)</td>
<td>1.41478</td>
<td>0.34412</td>
<td>0.34412</td>
<td>0.89858</td>
<td>0.26296</td>
<td>0.98035</td>
</tr>
<tr>
<td>Total Margin Length (m)</td>
<td>8350.45</td>
<td>4985.41</td>
<td>3553.54</td>
<td>8998.67</td>
<td>2460.08</td>
<td>5556.8</td>
</tr>
<tr>
<td>Total Margin Length (km)</td>
<td>8.35045</td>
<td>4.98541</td>
<td>3.55354</td>
<td>8.99867</td>
<td>2.46008</td>
<td>5.5568</td>
</tr>
<tr>
<td>Fraction of Total Length</td>
<td>0.0018</td>
<td>0.00301</td>
<td>0.00422</td>
<td>0.00167</td>
<td>0.0061</td>
<td>0.0027</td>
</tr>
<tr>
<td># Entering Buffer</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>Field</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------</td>
<td>------</td>
<td>------</td>
<td>------</td>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>Point 1 % of Total Drainage</td>
<td>0.48375</td>
<td>0.217</td>
<td>0.36698</td>
<td>0.20502</td>
<td>0.47487</td>
<td>0.30721</td>
</tr>
<tr>
<td>Point 2 % of Total Drainage</td>
<td>0.1165</td>
<td>0.11273</td>
<td>0.15379</td>
<td>0.10531</td>
<td>0.06199</td>
<td>0.22595</td>
</tr>
<tr>
<td>Point 3 % of Total Drainage</td>
<td>0.08611</td>
<td>0.08314</td>
<td>0.0769</td>
<td>0.07533</td>
<td>0.05301</td>
<td>0.12728</td>
</tr>
<tr>
<td>Point 4 % of Total Drainage</td>
<td>0.05867</td>
<td>0.04627</td>
<td>0.05149</td>
<td>0.04315</td>
<td>0.0487</td>
<td>0.0966</td>
</tr>
<tr>
<td>Point 5 % of Total Drainage</td>
<td>0.01984</td>
<td>0.03335</td>
<td>0.03913</td>
<td>0.04144</td>
<td>0.0259</td>
<td>0.02653</td>
</tr>
<tr>
<td>Point 6 % of Total Drainage</td>
<td>0.01055</td>
<td>0.03288</td>
<td>0.03296</td>
<td>0.03785</td>
<td>0.02331</td>
<td>0.01741</td>
</tr>
<tr>
<td>Point 7 % of Total Drainage</td>
<td>0.00929</td>
<td>0.02795</td>
<td>0.03124</td>
<td>0.03657</td>
<td>0.01848</td>
<td>0.01036</td>
</tr>
<tr>
<td>Point 8 % of Total Drainage</td>
<td>0.00844</td>
<td>0.02513</td>
<td>0.02643</td>
<td>0.03096</td>
<td>0.0164</td>
<td>0.01036</td>
</tr>
<tr>
<td>Point 9 % of Total Drainage</td>
<td>0.00844</td>
<td>0.02043</td>
<td>0.01648</td>
<td>0.01828</td>
<td>0.01295</td>
<td>0.00335</td>
</tr>
<tr>
<td>Point 10 % of Total Drainage</td>
<td>0.00802</td>
<td>0.02043</td>
<td>0.01648</td>
<td>0.01828</td>
<td>0.01295</td>
<td>0.00335</td>
</tr>
<tr>
<td>Total Top Ten Drainage</td>
<td>0.80962</td>
<td>0.62095</td>
<td>0.81325</td>
<td>0.61458</td>
<td>0.74944</td>
<td>0.84494</td>
</tr>
<tr>
<td>Min Elevation</td>
<td>16.9447</td>
<td>17.9547</td>
<td>17.9385</td>
<td>34.3129</td>
<td>26.5551</td>
<td>2.35804</td>
</tr>
<tr>
<td>Max Elevation</td>
<td>24.977</td>
<td>32.2979</td>
<td>29.0301</td>
<td>46.8901</td>
<td>42.8617</td>
<td>4.87308</td>
</tr>
<tr>
<td>Relief</td>
<td>8.0323</td>
<td>14.3432</td>
<td>11.0916</td>
<td>12.5772</td>
<td>16.3066</td>
<td>2.51504</td>
</tr>
<tr>
<td>Area</td>
<td>853337</td>
<td>344648</td>
<td>180696</td>
<td>323795</td>
<td>462167</td>
<td>124676</td>
</tr>
<tr>
<td>Area (skm)</td>
<td>0.85334</td>
<td>0.34465</td>
<td>0.1807</td>
<td>0.3238</td>
<td>0.46217</td>
<td>0.12468</td>
</tr>
<tr>
<td>Total Margin Length (m)</td>
<td>1991.03</td>
<td>3146.39</td>
<td>2173.08</td>
<td>4423.02</td>
<td>4187.00</td>
<td>1888.35</td>
</tr>
<tr>
<td>Total Margin Length (km)</td>
<td>1.99103</td>
<td>3.14639</td>
<td>2.17308</td>
<td>4.42302</td>
<td>4.18700</td>
<td>1.88835</td>
</tr>
<tr>
<td>Fraction of Total Length</td>
<td>0.00753</td>
<td>0.00477</td>
<td>0.0069</td>
<td>0.00339</td>
<td>0.00358</td>
<td>0.00794</td>
</tr>
<tr>
<td># Entering Buffer</td>
<td>8</td>
<td>10</td>
<td>6</td>
<td>10</td>
<td>9</td>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point 1 % of Total Drainage</td>
<td>0.08996</td>
<td>0.54684</td>
<td>0.17722</td>
<td>0.31732</td>
<td>0.15395</td>
<td>0.20567</td>
</tr>
<tr>
<td>Point 2 % of Total Drainage</td>
<td>0.07571</td>
<td>0.06397</td>
<td>0.12712</td>
<td>0.08876</td>
<td>0.09346</td>
<td>0.13213</td>
</tr>
<tr>
<td>Point 3 % of Total Drainage</td>
<td>0.06747</td>
<td>0.06142</td>
<td>0.11963</td>
<td>0.06561</td>
<td>0.05413</td>
<td>0.1262</td>
</tr>
<tr>
<td>Point 4 % of Total Drainage</td>
<td>0.05172</td>
<td>0.02802</td>
<td>0.06989</td>
<td>0.06288</td>
<td>0.04052</td>
<td>0.04021</td>
</tr>
<tr>
<td>Point 5 % of Total Drainage</td>
<td>0.04873</td>
<td>0.01755</td>
<td>0.0583</td>
<td>0.03723</td>
<td>0.03682</td>
<td>0.0339</td>
</tr>
<tr>
<td>Point 6 % of Total Drainage</td>
<td>0.04348</td>
<td>0.01557</td>
<td>0.04154</td>
<td>0.03451</td>
<td>0.03505</td>
<td>0.0332</td>
</tr>
<tr>
<td>Point 7 % of Total Drainage</td>
<td>0.03673</td>
<td>0.01302</td>
<td>0.03385</td>
<td>0.01952</td>
<td>0.0312</td>
<td>0.03102</td>
</tr>
<tr>
<td>Point 8 % of Total Drainage</td>
<td>0.03373</td>
<td>0.01189</td>
<td>0.03156</td>
<td>0.01907</td>
<td>0.02647</td>
<td>0.02432</td>
</tr>
<tr>
<td>Point 9 % of Total Drainage</td>
<td>0.03298</td>
<td>0.01104</td>
<td>0.0246</td>
<td>0.01816</td>
<td>0.02455</td>
<td>0.01589</td>
</tr>
<tr>
<td>Point 10 % of Total Drainage</td>
<td>0.03223</td>
<td>0.01076</td>
<td>0.02122</td>
<td>0.01657</td>
<td>0.02366</td>
<td>0.01475</td>
</tr>
<tr>
<td>Total Top Ten Drainage</td>
<td>0.51274</td>
<td>0.78007</td>
<td>0.70922</td>
<td>0.67968</td>
<td>0.51982</td>
<td>0.65741</td>
</tr>
<tr>
<td>Min Elevation</td>
<td>35.8358</td>
<td>40.1703</td>
<td>35.5036</td>
<td>1.48298</td>
<td>18.3812</td>
<td>15.5777</td>
</tr>
<tr>
<td>Max Elevation</td>
<td>46.1021</td>
<td>49.9341</td>
<td>46.2148</td>
<td>8.18224</td>
<td>30.7265</td>
<td>42.5447</td>
</tr>
<tr>
<td>Area</td>
<td>101128</td>
<td>320261</td>
<td>427265</td>
<td>2439.78</td>
<td>2994.11</td>
<td>4.72515</td>
</tr>
<tr>
<td>Area (skm)</td>
<td>0.10113</td>
<td>0.32026</td>
<td>0.42726</td>
<td>0.40703</td>
<td>0.59837</td>
<td>0.47252</td>
</tr>
<tr>
<td>Total Margin Length (m)</td>
<td>2439.78</td>
<td>2994.11</td>
<td>4.59657</td>
<td>3.08421</td>
<td>5.13615</td>
<td>4.47566</td>
</tr>
<tr>
<td>Total Margin Length (km)</td>
<td>2.43978</td>
<td>2.99411</td>
<td>4.59657</td>
<td>3.08421</td>
<td>5.13615</td>
<td>4.47566</td>
</tr>
<tr>
<td>Fraction of Total Length</td>
<td>0.00615</td>
<td>0.00501</td>
<td>0.00326</td>
<td>0.00486</td>
<td>0.00292</td>
<td>0.00335</td>
</tr>
<tr>
<td># Entering Buffer</td>
<td>7</td>
<td>10</td>
<td>10</td>
<td>8</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>Field</td>
<td>19</td>
<td>20</td>
<td>21</td>
<td>22</td>
<td>23</td>
<td>24</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>Point 1 % of Total Drainage</td>
<td>0.18058</td>
<td>0.39986</td>
<td>0.23827</td>
<td>0.1706</td>
<td>0.5619</td>
<td>0.24395</td>
</tr>
<tr>
<td>Point 2 % of Total Drainage</td>
<td>0.16454</td>
<td>0.08292</td>
<td>0.14925</td>
<td>0.11582</td>
<td>0.1271</td>
<td>0.10965</td>
</tr>
<tr>
<td>Point 3 % of Total Drainage</td>
<td>0.06818</td>
<td>0.07242</td>
<td>0.10404</td>
<td>0.11578</td>
<td>0.08914</td>
<td>0.06186</td>
</tr>
<tr>
<td>Point 4 % of Total Drainage</td>
<td>0.06248</td>
<td>0.07076</td>
<td>0.0591</td>
<td>0.07843</td>
<td>0.02998</td>
<td>0.05449</td>
</tr>
<tr>
<td>Point 5 % of Total Drainage</td>
<td>0.0323</td>
<td>0.05867</td>
<td>0.05417</td>
<td>0.071</td>
<td>0.0272</td>
<td>0.04877</td>
</tr>
<tr>
<td>Point 6 % of Total Drainage</td>
<td>0.03029</td>
<td>0.04054</td>
<td>0.05101</td>
<td>0.04602</td>
<td>0.01792</td>
<td>0.04477</td>
</tr>
<tr>
<td>Point 7 % of Total Drainage</td>
<td>0.02945</td>
<td>0.04011</td>
<td>0.04464</td>
<td>0.04283</td>
<td>0.01201</td>
<td>0.02961</td>
</tr>
<tr>
<td>Point 8 % of Total Drainage</td>
<td>0.02681</td>
<td>0.03055</td>
<td>0.03999</td>
<td>0.0364</td>
<td>0.01104</td>
<td>0.02433</td>
</tr>
<tr>
<td>Point 9 % of Total Drainage</td>
<td>0.01625</td>
<td>0.02058</td>
<td>0.02266</td>
<td>0.02496</td>
<td>0.00738</td>
<td>0.01758</td>
</tr>
<tr>
<td>Point 10 % of Total Drainage</td>
<td>0.0153</td>
<td>0.01857</td>
<td>0.02025</td>
<td>0.02235</td>
<td>0.00677</td>
<td>0.01668</td>
</tr>
<tr>
<td>Total Top Ten Drainage</td>
<td>0.62617</td>
<td>0.83497</td>
<td>0.78337</td>
<td>0.7242</td>
<td>0.89043</td>
<td>0.6517</td>
</tr>
<tr>
<td>Min Elevation</td>
<td>0.28894</td>
<td>87.7323</td>
<td>73.7692</td>
<td>69.4825</td>
<td>74.7815</td>
<td>60.9146</td>
</tr>
<tr>
<td>Max Elevation</td>
<td>5.80481</td>
<td>127.411</td>
<td>118.038</td>
<td>104.77</td>
<td>107.19</td>
<td>105.1189</td>
</tr>
<tr>
<td>Relief</td>
<td>5.51587</td>
<td>39.679</td>
<td>44.2686</td>
<td>35.2876</td>
<td>27.6772</td>
<td>46.2752</td>
</tr>
<tr>
<td>Area (skm)</td>
<td>658415</td>
<td>274004</td>
<td>281277</td>
<td>617513</td>
<td>187614</td>
<td>488196</td>
</tr>
<tr>
<td>Area</td>
<td>0.65841</td>
<td>0.274</td>
<td>0.28128</td>
<td>0.61751</td>
<td>0.18761</td>
<td>0.4882</td>
</tr>
<tr>
<td>Total Margin Length (m)</td>
<td>4611.92</td>
<td>3141.01</td>
<td>4021</td>
<td>5089.33</td>
<td>2423.95</td>
<td>5965.86</td>
</tr>
<tr>
<td>Total Margin Length (km)</td>
<td>4.61192</td>
<td>3.14101</td>
<td>4.021</td>
<td>5.08933</td>
<td>2.42395</td>
<td>5.96586</td>
</tr>
<tr>
<td># Entering Buffer</td>
<td>8</td>
<td>10</td>
<td>8</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td># Entering Buffer</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>252</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>26</th>
<th>27</th>
<th>Average</th>
<th>Std Deviation</th>
<th>1 Std Below</th>
<th>1 Std Above</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point 1 % of Total Drainage</td>
<td>0.40069</td>
<td>0.40069</td>
<td>0.302584624</td>
<td>0.14223209</td>
<td>0.160351415</td>
<td>0.444817834</td>
</tr>
<tr>
<td>Point 2 % of Total Drainage</td>
<td>0.14248</td>
<td>0.35118</td>
<td>0.130856718</td>
<td>0.060495734</td>
<td>0.070360985</td>
<td>0.191352452</td>
</tr>
<tr>
<td>Point 3 % of Total Drainage</td>
<td>0.13388</td>
<td>0.10271</td>
<td>0.089514503</td>
<td>0.02683161</td>
<td>0.062682892</td>
<td>0.11634113</td>
</tr>
<tr>
<td>Point 4 % of Total Drainage</td>
<td>0.11957</td>
<td>0.01275</td>
<td>0.059548119</td>
<td>0.024546507</td>
<td>0.03501612</td>
<td>0.084094625</td>
</tr>
<tr>
<td>Point 5 % of Total Drainage</td>
<td>0.01878</td>
<td>0.01063</td>
<td>0.040725643</td>
<td>0.016785427</td>
<td>0.023940216</td>
<td>0.057511069</td>
</tr>
<tr>
<td>Point 6 % of Total Drainage</td>
<td>0.01541</td>
<td>0.00777</td>
<td>0.03392462</td>
<td>0.014952001</td>
<td>0.018440641</td>
<td>0.048344463</td>
</tr>
<tr>
<td>Point 7 % of Total Drainage</td>
<td>0.01383</td>
<td>0.00752</td>
<td>0.029069716</td>
<td>0.014442607</td>
<td>0.016427649</td>
<td>0.043511784</td>
</tr>
<tr>
<td>Point 8 % of Total Drainage</td>
<td>0.01197</td>
<td>0.00494</td>
<td>0.02527543</td>
<td>0.012775357</td>
<td>0.012500073</td>
<td>0.038050788</td>
</tr>
<tr>
<td>Point 9 % of Total Drainage</td>
<td>0.01149</td>
<td>0.00455</td>
<td>0.019203579</td>
<td>0.009068765</td>
<td>0.010134814</td>
<td>0.028272344</td>
</tr>
<tr>
<td>Point 10 % of Total Drainage</td>
<td>0.0106</td>
<td>0.00433</td>
<td>0.016394459</td>
<td>0.007138541</td>
<td>0.009255917</td>
<td>0.023533</td>
</tr>
<tr>
<td>Total Top Ten Drainage</td>
<td>0.87871</td>
<td>0.90706</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Min Elevation</td>
<td>65.6664</td>
<td>42.5036</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max Elevation</td>
<td>99.9105</td>
<td>101.062</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relief</td>
<td>34.2441</td>
<td>58.5581</td>
<td>2.51503849</td>
<td>58.55809784</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Area (skm)</td>
<td>149436</td>
<td>239472</td>
<td>101.12802</td>
<td>141477.614</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Area</td>
<td>0.14944</td>
<td>0.23947</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Margin Length (m)</td>
<td>2179</td>
<td>3514.86</td>
<td>1888.345992</td>
<td>8998.673573</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Margin Length (km)</td>
<td>2.179</td>
<td>3.51486</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fraction of Total Length</td>
<td>0.00688</td>
<td>0.00427</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td># Entering Buffer</td>
<td>10</td>
<td>10</td>
<td>252</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix B

Appendix B consists of graphs of distance around the field margin versus cumulative fraction of total field drained, for all 27 study fields (including both resolutions for field 25). Increases in the Y-direction (cumulative fraction of field drained) indicate surface flow exiting at the field margin. Large and steep increases indicate locations at the field margin with concentrated flow accumulation. Decreases in the Y-direction indicate flow entering the field. Fields in which cumulative fraction of field drained exceeds one represent instances of exiting drainage not originating from precipitation on the field but rather flow entering the field. Appendix C contains images of each field with flow accumulation maps. The zero distance value can be located on each field by the large red dot. The distances plotted on appendix B figures continue from the zero locations, counterclockwise around the field margin.
Cumulative Fraction of Field Drained (Field 14)
Distance Around Field Margin (m)

Cumulative Fraction of Field Drained (Field 15)
Distance Around Field (m)
Cumulative Fraction of Field Drained (Field 25 - 1.2 m)

Cumulative Fraction of Field Drained (Field 26)

Distance Along Field Margin (m)
Appendix C

Maps of all 27 study fields created in ArcMap. Each map includes imagery of field with field outline, created by polyline snapped to flow accumulation points using the field margin as seen in imagery. The red point indicates starting location for distance vs accumulation graphs in Appendix B (continuing in a clock-wise direction around the field). The green shapefile indicates official riparian buffer, obtained from individual county offices. Fields 1 – 9 are from Charles City County with a riparian buffer shapefile that is a line designating buffered stream. Fields 10 – 27 are from either James City County or New Kent County with a riparian buffer shapefile designating the entire buffered area.
Appendix D

Detailed bulleted methods for GIS flow accumulation, GIS correction for flow direction, Excel analyses and GIS slope/area relationship.

GIS Methods – For flow accumulation/flow direction at field margin

- Download DEM
  - 10 m – USGS Seamless server
  - 2 m – Digital Coast
  - 1.2 m – (USGS, 2011)
- DEM added to blank ArcMap data frame and reproject into UTM NAD 1983 Zone 18N using:
  - Data Management tools → Projections/transformations → Raster → Project raster
    - Input Raster: DEM file
    - Output Raster: DEM file in new projection with new name
    - Resampling technique: Nearest
    - Output Cell Size: Default
    - Registration Point: Default
- Create a polygon shapefile in ArcCatalog to “extract by mask” the DEM file by to create smaller layers for each field. This is necessary for later when displaying flow accumulation raster to locate high flow accumulation paths. Be sure polygon is large enough to include the nearby buffered perennial stream.
- Flow accumulation determined on field using reprojected (extracted) DEM and the Hydrology Toolbox:
  - Spatial Analyst Tools → Hydrology → Fill
    - Input surface raster: Reprojected DEM
    - Output surface raster: Filled DEM with new name
    - Z limit: Default
  - Spatial Analyst Tools → Hydrology → Flow Direction
    - Input surface raster: Filled DEM saved in previous step
    - Output flow direction raster: Flow direction raster saved with new name
    - Force all edge cells to flow outward: Default
    - Output drop raster: Default
  - Spatial Analyst Tools → Hydrology → Flow Accumulation
    - Input Flow direction raster: Flow direction raster saved in previous step
• Output accumulation raster: Accumulation raster saved with new name
• Input weight raster: Default
• Output data type: Integer

• Convert flow accumulation raster to points using
  o Conversion tools → From Raster → Raster to Point
    ▪ Input Raster: Flow accumulation raster saved in previous step
    ▪ Field: Value
    ▪ Output Point features: Flow accumulation saved with same name but as a shapefile (.shp)

• Create polyline shapefile
  o ArcCatalog→ Right click in contents tab of specific field folder→ New→ Shapefile
    ▪ Name: New name including field number and file type
    ▪ Feature Type: Polyline
    ▪ Spatial Reference→ Edit→ Select→ Projected Coordinate Systems→ UTM→ NAD 1983→ NAD 1983 UTM Zone 18N.prj
  o Add new polyline shapefile to ArcMap data frame

• Add VA imagery
  o ArcCatalog→ GIS Servers (lower left in Table of Contents)→ Add ArcGIS Server (Double Click) → Use GIS Servers
    ▪ Internet Server: http://garden.wm.edu/arCGIS/services
    ▪ User Name and Password: Leave Blank

• View flow accumulation point file over imagery and flow accumulation raster
  o Display accumulation raster 60% transparent to allow field margin to be seen
    ▪ Right Click Layer → Properties → Display → Transparency: 60

• Begin Editing Session
  o Select Polyline Layer, allow for snapping
    ▪ Right click→ snap to vertices

• Beginning on field margin, snap polyline to accumulation points (each polyline vertex will be attached to one flow accumulation point) and proceed around field in clockwise direction.
  o Snap to points around field which allow for no double counting of flow (don’t follow a line of flow, snapping to each point, instead snap to the point closest to the field margin which the entire path flows to and go around other points)
  o If vertices need to be deleted while creating polyline
    ▪ Right click on the point → Delete Vertex
  o **Finish sketch** before saving or before ending editing session
    ▪ On Feature Construction Toolbar (should be in view on data frame during polyline creation) → Finish Sketch
  o Editor Toolbar: Save Edits→Stop Editing
  o If polyline needs to be edited, start editing and select entire line, then select Edit Vertices on editor toolbar to change individual vertices

• Use ETGeowiz tools to extract flow accumulation values by the snapped vertices
• ETGeowiz Toolbox →surface→Features to 3D
  ▪ Feature Layer: Polyline
  ▪ Raster of TIN Layer: Flow accumulation raster (not point file)
  ▪ Output feature class or shapefile: New Geowiz layer saved with new name

• Create Profile of distance vs. accumulation around field margin
  o 3D analyst tools →Conversion→ From feature class →Z to ASCII
    ▪ Input Feature Class: Geowiz file saved in previous step
    ▪ Output location: Specific field folder (not a file name)
    ▪ Output text file: new text file of distance and accumulation saved with new name (.txt)
    ▪ Output File Format: Profile
    ▪ Delimiter: Comma
    ▪ Decimal Notation: Default
    ▪ Digits after Decimal: Default
    ▪ Decimal Separator: Default

• Create XYZ data file for field margin
  o 3D analyst tools →Conversion→ From feature class →Z to ASCII
    ▪ Input Feature Class: Geowiz file saved earlier
    ▪ Output location: Specific field folder (not a file name)
    ▪ Output text file: new text file of XYZ data saved with new name (.txt)
    ▪ Output File Format: XYZ
    ▪ Delimiter: Comma
    ▪ Decimal Notation: Default

• Open both files in ArcCatalog (will open as text files) and add titles to columns
  o XYZ file: N,E,Z
  o Profile file: Distance, Accumulation

• Add each file to map using:
  o File→ Add data→ Add xy data
    ▪ X field: N/Distance
    ▪ Y Field: E/Accumulation
    ▪ Z Field: Z/Default
    ▪ Coordinate system should automatically be NAD 83, but can edit it if necessary

• Export each layer as a shape file and add to map so the data can be edited
  o Right click layer→Data→ Export Data
    ▪ Export: All features
    ▪ This layer’s source frame
    ▪ Output feature class: new file in field folder with same name as profile and XYZ text files but saved as shape files (.shp)
    ▪ Add to map when prompted by pop-up window

• Change flow onto field to negative values using flow direction arrows (Excel flow direction methods further down)
  o Convert Flow Direction to points:
  o Conversion tools →From Raster →Raster to Point
- Input Raster: Flow direction layer saved earlier
- Field: Value
- Output Point features: Flow direction saved with same name but as a shapefile (.shp)

- Clip flow direction points by polyline:
  - Analysis tools → Extract → Clip
    - Input Features: Flow direction point file saved in previous step
    - Clip Features: Polyline file saved earlier
    - Output Feature Class: Flow direction points at field margin (Saved as new name .shp)
    - XY Tolerance: Default

- Use symbology to display margin flow direction margin points as arrows angled appropriately with gridcode
  - Right click layer → Properties → Symbology Tab:
    - Category → unique value
      - Value Field: Gridcode
      - Click Add all values – double click each symbol with each value and change to arrow
        - Edit Symbol → Properties: Arrow Marker Symbol
        - Angle: As follows by gridcode
          - 1:0, 2:315, 4:270, 8:225, 16:180, 32:135, 64:90, 128:45

- View arrows over transparent flow accumulation raster and field image, with XYZ shape file as topmost layer (so they will be selected when using select by rectangle)

- Open XYZ layer attribute table and add field: Use field calculator to make new field values equal to Z field

- Select XYZ points using select by rectangle tool (can hold control button to select multiple groups)
  - Select points where flow direction is onto the field, but be sure to check that flow accumulation raster agrees with the flow direction arrow. Once selected right click the new field and change values to \( Z^*(-1) \)
  - Select points where flow is parallel to field and change values to \( (0) \). Again, be sure the flow is not coming onto or off the field by determining the values of accumulation pixels nearby. If flow touches margin but does not enter or exit the field value is \( (0) \)
  - Be sure to clear selected features when finished

- Join xyz shape file just edited to the profile shape file:
  - Right click XYZ layer → joins and relates → joins
    - Join Attributes from a table
    - Field: FID
    - Table to Join: profile shapefile
    - Field: FID
    - Join Options: Keep all records
• Export attribute table information from the xyz shape file as a text file so the data can be used in Excel
  o Open Attribute Table→Table Options→Export
    ▪ Export: All records
    ▪ Output table: Save XYZ file as a text file (.txt)
• Change flow onto field to negative values using Excel
  o Join profile and XYZ files:
    ▪ Right click XYZ layer → joins and relates → joins
    • Join Attributes from a table
    • Field: FID
    • Table to Join: profile shapefile
    • Field: FID
    • Join Options: Keep all records
  o Sample Flow Direction raster file by XYZ layer
    ▪ Spatial Analyst Tools→ Extraction→ Sample:
    • Input Rasters: Flow Direction raster created earlier
    • Input Location or Point Features: XYZ shapefile
    • Output Table: Table of XYZ locations with flow direction value saved as new name
    • Resampling Technique: Nearest
  o Add table to ArcMap using Add data
  o Join table to XYZ file:
    ▪ Right click XYZ layer → joins and relates → joins
    • Join Attributes from a table
    • Field: FID
    • Table to Join: Table saved in previous step
    • Field: FID
    • Join Options: Keep all records
  o Open XYZ attribute table and export data as text file

Excel Methods

• Open file – text file exported from xyz shapefile in ArcMap
• Tell excel that each value is delineated by a comma, it should automatically ask
• Add column of Area Drained
  o Calculate by multiplying field with positive and negative Z values by the area of each pixel (100 for 10m DEMs etc…)
  o This will be the field created when changing flow direction using flow direction arrows or the final corrected flow accumulation value in the excel method
• Add column of Cumulative Area Drained
Calculate by adding a formula in the second cell of the new column (=SUM($K$1:K2) if K1 is the first cell in the Area Drained column. Copy and paste down the column and each cell will be the Sum of the range from the first cell to itself

- Add column of Area Drained/Total Area
  - Calculate by dividing the Area Drained values by the cumulative Sum found at the bottom of the Cumulative Area Drained column

- Add column of Cumulative Area Drained/Total Area
  - Calculate by adding a formula in the second cell of the new column (=SUM($K$1:K2) if K1 is the first cell in the Area Drained/Total Area column. Copy and paste down the column and each cell will be the Sum of the range from the first cell to itself
  - The final value should be 1 or very near if done correctly

- Top Ten drainage locations
  - Copy and paste the column of area drained so that it can be sorted without disrupting other data
  - Sort area drained from largest to smallest and delete all values less than or equal to zero (We want to know the percent of total drainage exiting the field)
  - Sum these areas to get total exiting area
  - Divide each of the ten highest drainage areas by this total to get percent of total drainage each point comprises
  - Sum these percentages to get total fraction of field drained by the ten highest locations

GIS and Excel Methods – for area/slope relationship

- Create slope raster for field
  - Spatial Analysts toolbox→ Surface→ Slope
    - Input Raster: Filled and reprojected DEM
    - Output Raster: Raster of slope values saved as new name
    - Output Measurement: Degree
    - Z Factor: Default (would be used if Z and XY units vary)

- Sample slope raster by XYZ points
  - Spatial Analyst Tools→ Extraction→ Sample:
    - Input Rasters: Slope raster
    - Input Location or Point Features: XYZ shapefile
    - Output Table: Table of XYZ locations with slope value saved as new name
    - Resampling Technique: Nearest

- Join table of XYZ points with slopes to XYZ point file and export attribute table as text for use in Excel
Using GPS points identify XYZ point corresponding to in-field evidence of flow (since there aren’t very many of them this is actually much simpler than trying to join them. Also, distances between GPS and GIS points vary) – record FID

These points can easily be removed into a new sheet (using FID) in excel and given classes from field notes using the attribute tables in GIS file of GPS points

Area/slope relationship is generated with a scatter plot of slope degree on X-axis and Area drained (calculated in earlier excel steps) on Y-axis

The remaining margin points’ areas and slopes can be plotted to identify locations without channel formation or surface flow evidence (using only the margin of field walked!)